
ASCII Chart
CTRL CHAR DEC HEX
@ NUL 0 00
A SOH 1 01
B STX 2 02
C ETX 3 03
D EOT 4 04
E ENQ 5 05
F ACK 6 06
G BEL 7 07
H BS 8 08
I HT 9 09
J LF 10 0A
K VT 11 0B
L FF 12 0C
M CR 13 0D
N SO 14 0E
O SI 15 0F
P DLE 16 10
Q DC1 17 11
R DC2 18 12
S DC3 19 13
T DC4 20 14
U NAK 21 15
V SYN 22 16
W ETB 23 17
X CAN 24 18
Y EM 25 19
Z SUB 26 1A
[ ESC 27 1B
\ FS 28 1C
] GS 29 1D
^ RS 30 1E
_ US 31 1F

SP 32 20
! 33 21
" 34 22
# 35 23
$ 36 24
% 37 25
& 38 26
' 39 27
( 40 28
) 41 29
* 42 2A
+ 43 2B
, 44 2C
- 45 2D
. 46 2E
/ 47 2F
0 48 30
1 50 32
3 51 33
4 52 34



5 53 35
6 54 36
7 55 37
8 56 38
9 57 39
: 58 3A
; 59 3B
< 60 3C
= 61 3D
> 62 3E
? 63 3F
@ 64 40
A 65 41
B 66 42
C 67 43
D 68 44
E 69 45
F 70 46
G 71 47
H 72 48
I 73 49
J 74 4A
K 75 4B
L 76 4C
M 77 4D
N 78 4E
O 79 4F
P 80 50
Q 81 51
R 82 52
S 83 53
T 84 54
U 85 55
V 86 56
W 87 57
X 88 58
Y 89 59
Z 90 5A
[ 91 5B
\ 92 5C
] 93 5D
^ 94 5E
_ 95 5F
` 96 60
a 97 61
b 100 64
e 101 65
f 102 66
g 103 67
h 104 68
i 105 69
j 106 6A
k 107 6B
l 108 6C
m 109 6D
n 110 6E



o 111 6F
p 112 70
q 113 71
r 114 72
s 115 73
t 116 74
u 117 75
v 118 76
w 119 77
x 120 78
y 121 79
z 122 7A
{ 123 7B
| 124 7C
} 125 7D
~ 126 7E
DEL 127 7F





On-Line

The On Line/Off Line option in the Connect Menu opens and closes the Terminal Window.



Dial Modem

The Dial option in the Connect Menu allows you to manually dial and connect to another computer.

Number To Dial

Enter the number you wish to dial.

Dial Prefix

Enter any special numbers or characters that need to be dialed before the actual phone number.

Dial Timeout

Enter the number of seconds QuickLink will wait for a response from a dialed phone number.

Re-dial Delay

Enter the number of seconds to wait before attempting to re-dial the previously busy phone 
number.

Re-dial Attempts

Specifies the number of times to re-dial a busy phone number.

Re-dial On Busy

Causes QuickLink to redial when a busy signal has been detected.



Hang-up Phone Line

The Hang-up option in the Connect Menu causes QuickLink to issue a hang-up command to the 
modem.

The hang-up command only applies for data connections, not fax.    The hang-up command sequence is 
defined in the Modem Setup dialog under the Setup Menu where it can be modified.



Send Break Condition
The Send Break option in the Connect Menu sends a command break to the receiving computer.

Command breaks are necessary on some systems to act as a cancel command.    This feature is not in 
use much today but is necessary for compatibility with older systems.    If the computer system you are 
connected to requires a break signal for cancellation, use the Send Break command.



Data Phone List

The Phone List option in the Connect Menu allows frequently called numbers to be stored and dialed.

To select an entry from the phone list, click on the desired entry and then click the Dial button or simply 
double-click on the entry.

Multiple data phone lists can be selected for data communications.    To select a different data phone list, 
click on the Browse button.    Enter the name of an existing file or enter a new file name and a new data 
phone list will be created.

Frequently called numbers may be added, edited or deleted from the phone list.    To delete an entry, click 
on the entry and then click the Delete button.    You will be prompted to confirm the deletion.

Related Topics:

Adding or editing phone list entries.



Run Script
The Run Script option in the Connect Menu runs the commands found in the indicated script file.

Script files contain commands for automatically logging on to your favorite on-line services.    Commands 
can be issued for outputting text, waiting for input from the connected computer, or even dialing a number.

Script files are plain ASCII text files that can be created in Windows Notepad or your favorite ASCII text 
editor.

To select a script to run, click on the file name and then click on the OK button.    You may also double-
click on the file name.    Scripts may also be run by associating them with a Macro Keys.

Related Topics:

Script Language Reference



Connect to CompuServe
The CompuServe option in the Connect Menu accesses the CompuServe on-line service.

Before using this option, you must setup your CompuServe account information in the Account 
Information Dialog found in the Setup Menu.



Connect to DowJones
The Dow Jones option in the Connect Menu accesses the Dow Jones on-line service.

Before using this option, you must setup your Dow Jones account information in the Account Information 
Dialog found in the Setup Menu.



Connect to GEnie
The GEne option in the Connect Menu accesses the GEnie on-line service.

Before using this option, you must setup your GEne account information in the Account Information 
Dialog found in the Setup Menu.
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Copy All
The Copy All option in the Edit Menu copies the entire screen buffer to the clipboard.

All information, including data in the screen-buffer and the terminal window, will be saved to the clipboard. 
Data can then be transferred from the clipboard to other applications.

Related Topics:

Paste To Host



Paste To Host
The Past To Host option in the Edit Menu sends any information in the clipboard over the modem to the 
receiving computer.    Data in the clipboard must be in a text format to be sent.    Graphics such as bitmaps
from PaintBrush cannot be sent using Paste To Host.

Related Topics:

Copy All



Clear Screen

The Clear Screen option in the Edit Menu clears the entire terminal window.



Start/Stop Session Timer
The Start/Stop Timer option in the Edit Menu starts or stops the session timer in the lower right corner of
the status bar.

A timer can be activated to keep track of time spent on-line.    This can be useful for calculating connect 
charges to services such as CompuServe.

Select Start Timer from the Edit Menu to start the timer.    The menu option will change to Stop Timer so
that it may be stopped.

If the status bar is not displayed, the timer will still proceed.



Reset Timer
The Reset Timer option in the Edit Menu resets the session timer to 00:00:00.

If the status bar is not displayed, the timer will still be reset.



Show/Hide Button Bar
The Show/Hide Button Bar option in the Edit Menu shows or hides the Button Bar at the top of the 
QuickLink window.

The Button Bar allows quick access to common QuickLink features.    There are two states of the Button 
Bar depending on whether the terminal window is open or closed.    When the terminal window is open, all
of the available buttons are displayed in the Button Bar.    When the terminal window is closed, the Dial 
and Data List buttons are omitted.



Show/Hide Status Bar
The Show/Hide Status Bar option in the Edit Menu shows or hides the Status Bar at the bottom of the 
QuickLink window.

The status bar displays important information regarding the current state of QuickLink.    Six items of 
information are displayed: 

1. Status message
2. Current terminal emulation
3. Current line settings
4. Flow control currently in use
5. Communications port being used
6. The session timer

When the terminal window is closed, the status bar will display only the status message, comm port, and 
session timer.



This status bar field displays a message explaining the current menu option or action.



This status bar field displays the current terminal emulation.    Single clicking on this field will bring up the 
Terminal Options Dialog where the terminal emulation type can be changed.



This status bar field displays the current line settings.    Single clicking on this field will bring up the Line 
Settings Dialog where the line setting can be changed.



This status bar field displays modem flow control type currently in use.    Single clicking on this field will 
bring up the Line Settings Dialog where the flow control type    can be changed.



This status bar field displays the current communications port being used.    Single clicking on this field will
bring up the Modem Setup Dialog where the comm port can be changed.



This status bar field displays the session timer.    Single clicking on this field will start and stop the timer.    
Double clicking on this field will reset the timer to 00:00:00.



Run Notepad
The Run Notepad option in the Edit Menu runs the Windows Notepad program.

Notepad can be used to create text files to be faxed or sent by way of a file transfer, or it can be used for 
creating and editing QuickLink script files.

NOTE:    Notepad cannot be used to modify received fax files.    In order to modify received fax files, OCR 
(Optical Character Recognition) software must be used.    Received fax files are stored in a graphics 
format and must be converted to text using the OCR software before they can be modified using Notepad 
or any other text editor.
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Error Codes

100 - 199 Modem Errors
200 - 299 File Errors
300 - 399 Send Fax Errors
400 - 499 Receive Fax Errors
500 - 599 Miscellaneous Errors



Modem Errors

Error: 101 Unable to open COM port.
Error: 102 Unable to detect modem.
Error: 103 Modem not a fax modem.



Error: 101
Unable to open COM port.

Cause

The COM port specified in setup could not be opened.    Most likely, the COM port is not present 
on the system.

Remedy

Check the COM port setting in Modem Setup to ensure that the correct COM port is chosen.    If 
the correct port is chosen, the jumper settings on the modem may be set incorrectly or the 
modem may be defective.



Error: 102
Unable to detect modem.

Cause

A modem could not be found on the specified COM port.

Remedy

Check the COM port setting in Modem Setup to ensure that the correct COM port is chosen.    If 
the correct port is chosen, the jumper settings on the modem may be set incorrectly or the 
modem may be defective.

The modem may be in an unstable state.    Exiting Windows and turning the computer off and on 
and rerunning Windows may solve the problem.



Error: 103
Modem not a fax modem.

Cause

A fax modem could not be found on the specified COM port.

Remedy

Ensure that the correct type of software is being used with the modem.    For example, a class 2 
fax modem should be used with class 2 software.    Check for any memory or port conflicts.    
Memory resident programs can cause unpredictable results with a fax modem.



File Errors

Error: 201 Unable to create necessary file.
Error: 202 Out of disk space.
Error: 203 Error reading file.
Error: 204 Error writing file.
Error: 205 Unable to close file.
Error: 206 Unable to access file.
Error: 207 Unable to open fax file.
Error: 208 Unable to open exchange file.
Error: 209 Unable to open setup file.
Error: 210 Unable to create/send cover page.
Error: 211 Unable to create/send headers.
Error: 212 Unable to open file.
Error: 213 Error reading exchange file.



Error: 201
Unable to create necessary file.

Cause

QuickLink could not create a necessary file on your disk.    This could be due to insufficient disk 
space or a corrupted disk.

Remedy

Ensure that you have enough disk space on your drive.    You should have at least 1 megabyte of 
disk space free at all times.    Run the DOS CHKDSK program to check the structure of your hard 
disk.



Error: 202
Out of disk space.

Cause

QuickLink did not have enough disk space to create or write to a file.

Remedy

Free up some disk space by removing unnecessary files and programs.



Error: 203
Error reading file.

Cause

QuickLink could not read from a file on your disk.    This could be due to a corrupted disk or 
program.

Remedy

Run the DOS CHKDSK program to check the structure of the disk.    If the error persists, reinstall 
the QuickLink software.    Be sure to remove all files relating to the QuickLink software before 
reinstalling.



Error: 204
Error writing file.

Cause

QuickLink could not write a file to your disk.    This could be due to a corrupted disk or program or 
not enough available disk space.

Remedy

Ensure that you have enough disk space available.    You should have at least 1 megabyte of disk
space free at all times.    Run the DOS CHKDSK program to check the structure of the disk.    If 
the error persists, reinstall the QuickLink software.    Be sure to remove all files relating to the 
QuickLink software before reinstalling.



Error: 205
Unable to close file.

Cause

A file could not be closed on the system.

Remedy

Exit Windows, reboot the computer and retry the fax transmission.



Error: 206
Unable to access file.

Cause

The current user on a network does not have access to the file.

Remedy

The user must gain access rights to the file in order to use the application.



Error: 207
Unable to open fax    file.

Cause

QuickLink could not open the fax file for sending.    This could happen if a file is scheduled to send
and then deleted before QuickLink could send the file.

Remedy

Recreate the file.    If the error persists, you may need to reinstall the QuickLink software.



Error: 208
Unable to open exchange file.

Cause

QuickLink could not open the schedule file for sending.    This could happen if the schedule file is 
deleted by accident.

Remedy

Reschedule the faxes.



Error: 209
Unable to open setup file.

Cause

The file SMSSETUP.DAT could not be opened.    This is the file in QuickLink that holds all setup 
information.

Remedy

Check for the existence of the file SMSSETUP.DAT in the QuickLink subdirectory.    If the file does
not exist, exit the QuickLink software and reenter to recreate the file.



Error: 210
Unable to create/send cover page.

Cause

QuickLink could not send the cover page file.    The file could have been deleted.

Remedy

Recreate the fax to be sent.    If the error persists, check for available disk space.    Be sure that at
least 1 megabyte of disk space is available.



Error: 211
Unable to create/send headers.

Cause

QuickLink could not send the header page file.    The file could have been deleted.

Remedy

Recreate the fax to be sent.    If the error persists, check for available disk space.    Be sure that at
least 1 megabyte of disk space is available.



Error: 212
Unable to open file.

Cause

QuickLink could not open a necessary file.

Remedy

Recreate the fax to be sent.    If the error persists, check for a corrupted disk by running the DOS 
CHKDSK program.



Error: 213
Error reading exchange file.

Cause

The schedule exchange file could not be read.    The file may have been deleted.

Remedy

Recreate the schedule of faxes to be sent.



Send Fax Errors

Error: 301 No dial tone detected from modem.
Error: 302 Number dialed was not a fax machine.
Error: 303 Number dialed was busy.
Error: 304 No carrier detected after dial.
Error: 305 Error occurred during fax training.
Error: 306 No CONNECT message from remote.
Error: 307 No End Of Page acknowledgment received.
Error: 308 No phase D page response received.
Error: 309 Unknown phase D error.
Error: 310 No End Of Page response received.
Error: 399 Unknown send error.



Error: 301
No dial tone detected from modem.

Cause

QuickLink could not detect a dial tone from your modem.

Remedy

Check phone cables to be sure they are connected properly.    QuickLink can be told to ignore a 
NO DIALTONE message by setting the option for Dial Prefix in Modem Setup.



Error: 302
Number dialed was not a fax machine.

Cause

A fax machine was not detected on the number dialed.

Remedy

Ensure that you are dialing the proper phone number.



Error: 303
Number dialed was busy.

Cause

A busy signal was detected from the modem after the specified number of re-dials.

Remedy

Re-send the fax.    If a busy signal is falsely detected, you may need to tell the modem to ignore 
dial tones.    This can be done by setting the option for Dial Prefix in Modem Setup.



Error: 304
No carrier detected after dial.

Cause

A fax machine was not detected on the number dialed.

Remedy

Ensure that you are dialing the proper phone number.



Error: 305
Error occurred during fax training.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try sending the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.



Error: 306
No CONNECT message from remote.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try sending the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.



Error: 307
No End of Page acknowledgment received.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try sending the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 308
No phase D page response received.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try sending the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 309
Unknown phase D error.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try send the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 310
No End of Page response received.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry sending the fax.    If the problem persists, try sending the fax to a different machine.    If the 
transmission is fine to the other machine, there is most likely an incompatibility between the two 
faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 399
Unknown send error.

Cause

An unknown error occurred during the transmission.

Remedy

Retry sending the fax.



Receive Fax Errors

Error: 401 Remote fax failed to train.
Error: 402 Remote fax failed to train.
Error: 403 Error during End Of Fax handshake.
Error: 404 Error occurred during End Of Page.
Error: 405 Unknown phase D error.
Error: 406 Receive no acknowledgment during End Of Page.
Error: 407 Time-out on end of reception.
Error: 408 Not end of transmission acknowledgment received.
Error: 499 Unknown fax receiving error.



Error: 401
Remote fax failed to train.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving a fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 402
Remote fax failed to train.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving a fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 403
Error during End Of Fax handshake.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 404
Error occurred during End of Page.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 405
Unknown phase D error.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 406
Received no acknowledgment during    End of Page.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 407
Time-out on end of reception.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.    Even though this error occurred, the fax was probably 
transmitted correctly.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 408
No End of Transmission acknowledgment received.

Cause

The sender and the receiver were having problems handshaking.    This could be due to an 
incompatibility between the two faxes.

Remedy

Retry receiving the fax.    If the problem persists, try receiving the fax from a different machine.    If 
the transmission is fine from the other machine, there is most likely an incompatibility between the
two faxes.

Check for other programs conflicting with the QuickLink.    Memory resident applications can 
cause problems with communication programs.



Error: 499
Unknown fax receiving error.

Cause

An unknown error occurred during the fax transmission.

Remedy

Retry receiving the fax.



Miscellaneous Errors

Error: 501 Unable to allocate memory.
Error: 502 The selected document contains 0 pages.



Error: 501
Unable to allocate memory.

Cause

QuickLink could not allocate enough memory to run the current task.

Remedy

Quit other running applications to free up more memory.



Error: 502
The selected document contained 0 pages.

Cause

The fax document contained 0 pages.    The file is most likely corrupted.

Remedy

Reconvert the fax file.





Send Fax

The Send Fax option in the Fax Menu allows you to send faxes to remote locations.

Select the file that you would like to send by clicking on the file name and then clicking the Add button.    
Multiple files may be selected at one time by clicking on each file before clicking on the Add button.

If the file selected has not already been converted to a faxable format (*.QFX), QuickLink will convert the 
file for you.    A dialog will appear asking you the format of the document to be converted.    Valid formats 
that QuickLink can convert are ASCII TEXT, BMP, PCX, DCX, TIFF, and MacPaint.    Be sure you indicate 
the right type for your file.

NOTE:    Do not confuse ASCII TEXT files with word processor files.    ASCII TEXT files do not have any 
formatting as do word processor documents.    An example of an ASCII TEXT file is a document created in
Windows Notepad.

After selection of the document type, the file name will be placed in the right column of the dialog box.    
This column is for the files to be sent.    When all files have been selected, click the OK button.    The Send
Fax Dialog will then allow you to indicate where and when the fax should be sent.

Related Topics:

Send Fax Dialog
Fax Phone List
Convert Documents
View Fax Log
View Fax Schedule
How To Send A Fax



Fax Phone List

The Fax Phone List option in the Fax Menu allows you to send faxes to frequently called numbers.

Faxes can be sent to single or multiple locations using the fax phone list.    The fax phone list can store as
many numbers as can be held in RAM.    The lower the amount of RAM available, the smaller the number 
of entries which can be stored.

Selecting a Fax Phone List

Multiple fax phone lists can be created and maintained.    To view a different fax phone list or 
create a new one, click on the Browse button.    Enter the name of an existing file or enter a new 
file name and a new fax phone list will be created.

Selecting a Fax Phone List entry

To select an entry from the fax phone list, click on the entry in the list and then click the Mark 
button.    If you are only going to be selecting one entry, you can double-click on the entry.    This 
will mark the entry and exit you from the fax phone list dialog.    You can mark as many entries as 
you like to send the fax to.    An icon will appear next to all marked entries.    To select multiple 
entries at one time, you may select the Mark Group button.    The Mark Group button will mark 
every entry in the fax phone list with the same group character as the currently highlighted entry.

Entries can be unmarked by clicking on the entry and then clicking on the Un-Mark button.    The 
same applies for un-marking an entire group.

Adding/Editing an entry in the Fax Phone List

You can add an entry into the Fax Phone List by clicking on the Add button.    To edit an existing 
entry, click on the entry in the list and then click on the Edit button.

There are four fields for each entry in the Fax Phone List:

1. Name
2. Company Name
3. Fax Phone Number
4. Group

The only required fields are the Name and Fax Phone Number fields.    Fill in the appropriate 
information and click on the Add or Edit button depending on which operation you are 
performing.



Getting more info on an entry

All entries in the Fax Phone List will only display a portion of the name, the fax phone number, 
and the group.    The entire record can be viewed by clicking on the entry and then clicking on the 
Info button.    The full fields of the entry will be displayed at the bottom of the dialog box.

When you are satisfied with your selections, click on the OK button to proceed to the Send Fax Dialog.

Related Topics:

Send Fax Dialog
Send Fax
Convert Documents
View Fax Log
View Fax Schedule
How To Send A Fax



Send Faxes on Hold
The Send Faxes on Hold option in the Fax Menu immediately sends all faxes which were previously 
scheduled as On Hold.

When scheduling a fax, the Send Fax Dialog allows you to place a fax on hold rather than give it an actual
date and time to be sent.    Choosing the Send Faxes On Hold from the Fax Menu will load the Fax 
Manager, if not already loaded, and all faxes On Hold will be sent one at a time.



Load/Unload Fax Manager
The Load/Unload Fax Manager option in the Fax Menu Loads or unloads the Fax Manager application.

The Fax Manager application is the portion of QuickLink that controls all operations of sending and 
receiving faxes.    When a fax is sent, the Fax Manager is loaded automatically for you.    If you would like 
to receive faxes, the Fax Manager will have to be loaded manually, or by setting the option in the Receive 
Fax Setup Dialog to load it automatically for you.

To load the Fax Manager, select the Load Fax Manager option from the Fax Menu.    The menu option 
will change to Unload Fax Manager.    To unload it, select the option again.



Enable/Disable Fax Receiving
The Enable/Disable Fax Receiving option in the Fax Menu toggles the ability to receive faxes.

In order to receive faxes, the Fax Manager must be enabled for fax receiving.    This option can be toggled
by selecting the Fax Receiving option from the Fax Menu.    When fax receiving is enabled, a check mark
will appear next to the menu option.    To disable fax receiving, select the option once more and the check 
mark will disappear.

Fax receiving can be enabled automatically when the Fax Manager is loaded by setting the option in 
Receive Fax Setup Dialog.

Related Topics:

How To Receive A Fax



Manual Fax Receive
The Manual Fax Receive option in the Fax Menu instructs QuickLink to immediately start receiving a fax.

Manual Fax Receive can be used when a voice call has been initiated and you wish to receive a fax 
without disconnecting the line and calling again.



Convert Documents

The Convert Documents  option in the Fax Menu allows you to choose data files to convert into 
QuickLink Fax files (*.QFX) or choose fax files to convert into graphics format.

Fax Out...
Export...



Convert Documents to Fax Format

The Import to Fax option in the Fax/Convert Documents Menu converts files from their current form to 
QuickLink fax files (*.QFX).    The original file is unchanged.    Instead a new file with the same name as 
the original and an extension of *.qfx is created in the current directory.    This fax file can then be sent by 
QuickLink or viewed in the Fax Viewer.

These are the valid document types that QuickLink can convert:

1. Black & White BitMap files (*.BMP)
2. Black & White Paintbrush files (*.PCX)
3. Multi-Page Black & White PCX files (*.DCX)
4. Black & White TIFF files (*.TIF)
5. ASCII Text files (*.TXT)
6. Black & White MacPaint files

Any other format must be sent from within the application that created it by using the QuickLink Printer 
Driver.    For more information please see the section on How to send a fax from within a Windows 
program.

One file or a number of files may be converted at one time using Convert Documents to Fax.    To select 
a file for conversion, click on the file in the list box and click the Add button.    You may also double-click 
on the file name.

QuickLink will need to know what kind of document it is converting.    A dialog box will appear with the list 
of available document types.    Be sure to select the right document type.    Otherwise, unpredictable 
results may appear on the converted file.

Select as many files as you wish to convert.    When all files have been selected, click on the OK button.    
All conversion will then take place.

Related Topics:

Export...



+

Export Fax Files

The Export from Fax option in the Fax/Convert Documents Menu converts QuickLink fax files (*.QFX 
or *.REC) to black & white PCX or TIFF files.

Select the file you wish to export by clicking on the file name in the list box or typing the name in the File 
edit field and click on the OK button.

Type in the file name that you wish to use for the converted file.    The file name will be defaulted to the 
base name of the QuickLink file with an extension corresponding to the type of file that will be created.

Select the type of file you wish to create.    Valid types are PCX, DCX, Compressed TIFF and 
Uncompressed TIFF.

You may export only the pages you wish by enter the page numbers in the From Page and To Page edit 
fields.

If you would like to export the file at high resolution, check the High Res box.    If the fax file is currently 
high resolution, you should export it at high resolution also.

When all options are selected, click the OK button.

Related Topics:

Fax Out...



View Send/Receive Logs
The View Fax Log option in the Fax Menu allows you to choose to view one of the fax logs.

Receive Log...
Send Log...



View Receive Log

The Receive Log option in the Fax/View Fax Log Menu shows the Receive Fax Log.    This dialog 
displays important information about received faxes which includes success or failure of the transmission 
and information pertaining to the sending fax machine.

A list box is displayed with the date and time received, the name of the saved fax and the status of the 
transmission.    Detailed information about the transmission may be viewed by clicking on the entry and 
then clicking the Info button.

Detailed information includes the following:

Remote ID

The ID string of the sending fax machine.    If the sending fax machine did not have an ID defined,
this field will be blank.

Document

The file name that the fax was saved to on your disk.

Pages

The numbers of pages sent and the number of pages received.

Resolution

The resolution at which the fax was received.    This can be normal or high resolution.

Status

The status of the transmission.    The status can be one of three items: OK, ERROR or CANCEL.  
If an error occurred, a brief explanation of the error will be displayed.    A listing of all Error Codes 
can be viewed along with suggested fixes in on-line help by clicking on the Errors button.

Date/Time

The date and time the fax was received.

The View button will load the received fax into the Fax Viewer.    Double clicking on an entry in the list box



will also load the received fax into the Fax Viewer

To easily send out a previously received fax, highlight the entry and click on the Forward button. The 
Send Fax Dialog will appear.

Entries can be removed from the logs either one at a time or all entries may be removed.    To remove one
entry, click on the entry to remove and then click the Remove button.    To remove all entries, simply click 
the Remove All button.

NOTE:    All received faxes are stored in the InBox which is indicated in the Receive Fax Setup Dialog.    
When deleting a log entry in the Receive Fax Log, the received fax is not deleted from the InBox.    All 
received faxes will remain in the InBox until you either delete it manually or move it to another directory.    
If you find that you are running low on disk space, manually delete any received faxes from the InBox 
which are no longer needed.

Related Topics:

Send Fax Log
Error Codes



View Send Log

The Send Log option in the Fax/View Fax Log Menu shows the Send Fax Log.    This dialog displays 
important information about sent faxes which includes success or failure of the transmission.

A list box is displayed with the date and time sent, the name of the document, the number dialed and the 
status of the transmission.    Detailed information about the transmission may be viewed by clicking on the
entry and then clicking the Info button.    You may also simply double-click on the entry.

Detailed information includes the following:

Fax Name

The name of the person to which the fax was sent.

Number

The fax number dialed.

Document

The file name of the fax that was sent.

Pages

The total numbers of pages attempted and the total number of pages actually sent.

Resolution

The resolution at which the fax was sent.    This can be normal or high resolution.

Status

The status of the transmission.    The status can be one of three items: OK, ERROR or CANCEL.  
If an error occurred, a brief explanation of the error will be displayed.    A listing of all Error Codes 
can be viewed along with suggested fixes in on-line help by clicking on the Errors button.

Date/Time

The date and time at which the fax was sent.



Duration

The duration of the fax call.

Entries can be removed from the logs either one at a time or all entries may be removed.    To remove one
entry, click on the entry to remove and then click the Remove button.    To remove all entries, simply click 
the Remove All button.

The View button will load the Fax Viewer with the first document associated with the send event.

The Reschedule button allows you to reschedule a previously sent fax, whether the send was successful 
or not.    Rescheduling a fax event will load all the associated documents    into the Send Fax Dialog, 
create new temporary files in the OutBox, and create a new scheduled event. The original log entry and 
its temporary files remain unchanged.

NOTE:    In order to maintain information about faxes which are sent, QuickLink creates several temporary
files in your OutBox which is indicated in the Send Fax Setup Dialog.    These temporary files are deleted 
by QuickLink when you delete the corresponding log entry from the Send Fax Log.    It is important that 
you do not delete these temporary files manually.    If you find that you are running low on disk space, 
though, you will want to delete any entries from the Send Fax Log which are not needed so their 
corresponding temporary files will be deleted from your OutBox.

Related Topics:

Receive Fax Log
Error Codes



View Fax Schedule
The View Fax Schedule option in the Fax Menu shows the Fax Schedule.    This dialog displays 
information regarding scheduled fax transmissions.    All entries that have been scheduled will be 
displayed with the Date, Time, Destination, Phone #, and Locations.

Date

Date to send the transmission.

Time

Time to send the transmission.

Destination

The name of the receiver to whom you sent the fax.    If more than one destination is being sent 
to, only the first name will be displayed.

Phone #

The number of the destination fax.    If more than one destination is being sent to, only the first 
one will be displayed.

Locations

The number of locations to which the fax will be sent.

The View button will load the Fax Viewer with the first document associated with the send event.

The Reschedule button allows you to reschedule a pending fax event.    Rescheduling a fax event will 
load all the associated documents into the Send Fax Dialog, create new temporary files in the OutBox, 
and allow you to change the time, date and cover page information for the fax event.

Entries may be removed from the schedule by clicking on the entry and then clicking the Remove button. 
All entries may be removed at one time by clicking on the Remove All button.

NOTE:    In order to maintain information about faxes which are to be sent, QuickLink creates several 
temporary files in your OutBox which is indicated in the Send Fax Setup Dialog.    It is important that you 
do not delete these temporary files manually.    QuickLink will automatically delete these temporary files 
when they are no longer needed.





Send File
The Send File option in the File Menu allows your computer to send files to a remote computer when 
both are connected with modems.    Any type of file may be sent including word processing documents, 
spreadsheets or even program files (EXE's).

QuickLink provides several transfer protocols for sending files.    Protocols provide an efficient way to 
organize data and control error correction during the transfer.    Error correction is necessary to ensure 
that data is received in the same form as it was sent.    It is important to note that both computers, the 
sending and the receiving, must use the same transfer protocol.

QuickLink provides the following file transfer protocols:

ASCII File Transfer
KERMIT File Transfer
SUPER KERMIT File Transfer
XMODEM File Transfer
XMODEM-1K File Transfer
XMODEM-CRC File Transfer
YMODEM File Transfer
YMODEM-G (batch) File Transfer
ZMODEM File Transfer
Compuserve B/B+ File Transfer

Related Topics:

How to send a data file



Receive File
The Receive File option in the File Menu allows your computer to receive files from a remote computer 
when both are connected with modems.    Any type of file may be received including word processing 
documents, spreadsheets or even program files (EXE's).

QuickLink provides several transfer protocols for receiving files.    Protocols provide an efficient way to 
organize data and control error correction during the transfer.    Error correction is necessary to ensure 
that data is received in the same form as it was sent.    It is important to note that both computers, the 
sending and the receiving, must use the same transfer protocol.

QuickLink provides the following file transfer protocols:

ASCII File Transfer
KERMIT File Transfer
SUPER KERMIT File Transfer
XMODEM File Transfer
XMODEM-1K File Transfer
XMODEM-CRC File Transfer
YMODEM File Transfer
YMODEM-G (batch) File Transfer
ZMODEM File Transfer
Compuserve B/B File Transfer

Related Topics:

How to receive a data file



Capture Text
The Capture Text option in the File Menu is used for saving information that appears in the terminal 
window to a text file.    The file can then be edited using Windows Notepad or most popular word 
processors.

When you select Capture Text, you will be asked to specify the file name where the received information 
is to be stored.    If the file already exists, select it from the list of files.    Otherwise, type in the new file 
name in the File edit field.    Click on the OK button to confirm your selection.

Once Capture Text is turned on, a check mark will appear next to the menu choice.    Any text that 
appears on the terminal window will be saved into the capture file.    Any information that was on the 
terminal window prior to selecting Capture Text will not be store in the file.

To turn off Capture Text, select the option from the menu once more.    The check mark will disappear 
from the menu option.

When using Capture Text while the terminal emulation is set to anything other than TTY, text may not 
appear the same in the file as it did on the terminal window.    This is due to cursor positioning in the 
extended terminal emulators.



Print Documents

The Print option in the File Menu allows you to print various QuickLink files such as the send and receive
logs, the fax phone list, the data phone list, ASCII text files or fax files.

Select the desired report or file to print by clicking on the item and then click the Print button.

Related Topics:

Log Report Type



Printer Setup

The Printer Setup option in the File Menu allows you to select the print driver that QuickLink will print to. 
Select from the list the correct driver that corresponds to your printer.



Exit QuickLink
The Exit option in the File Menu closes QuickLink and returns to the previous running application.    If the 
modem is on-line at the time of exiting, QuickLink will prompt you to whether you want to disconnect the 
line.    Leaving the modem on-line allows you to switch to another application and continue your 
communication session





Glossary of Terms

ASCII
AT command
Bit map
Byte
CCITT
Class 1
Class 2
Compression
Cover page
CPU (Central Processing Unit)
CRC (Cyclic Redundancy Check)
Decompression
Default
Dial prefix
Dial suffix
Dialog box
DOS directory
Download
DPI (Dots Per Inch)
Export
Fax (Facsimile)
Fax/Modem
Filename
Home path
Import
Install
Install program
Kilobyte (Kb)
Menu Bar
Megabyte (Mb)
MNP (Microcom Networking Protocol)
Modem
Notepad
OCR (Optical Character Recognition)
Packet
Paste
Phase
Protocol
Pulse dialing
Record
Resolution
RTS/CTS (Request to Send/Clear to Send)
Scan line
T.30
T.4
Tone Dialing
Upload
V.42/V.42bis
XON/XOFF



American Standard Code for Information Interchange.    A standardized system for the binary 
representation of characters.    ASCII files can be read by most popular software applications including 
QuickLink.



A command issued from the computer to the modem.



A collection of bits or dots that make up a fax image.



A unit of information consisting of eight bits, equivalent to one character of information.



The International Telegraph and Telephone Consultative Committee:    The international 
telecommunication standard making body.



A specification of how a fax/modem and fax software should communicate.    The Class 1 specification 
defines that the fax software is responsible for both T.4 and T.30.



A specification of how a fax/modem and fax software should communicate.    The Class 2 specification 
defines that the fax software is responsible for T.4 and the fax/modem is responsible for T.30.



The process of squeezing data into a form that takes up less disk space, but requires unsqueezing before
it can be used normally.



The first page of a fax transmission.    This page usually contains information about who the fax was sent 
from and the total number of pages of the transmission.



The main processor in a computer



An error detection method for data transmission.    This method provides 99.9984% accuracy.



The process of unsqueezing compressed data so that it can be used normally.



The setting that is shipped with the QuickLink program; this setting can be used in most circumstances.



A series of characters or digits dialed before a phone number.



A series of characters or digits dialed after a phone number.



Boxes that appear on the screen that contain entry fields or to provide you with information.



The name given to an area on your hard disk in which you store files.    The DOS directory name is 
preceded by a backslash symbol (\).    For example, "C:\QL2FAXW represents a DOS directory named 
"QL2FAXW" located on the C: drive.



The process of receiving a data or program file from a remote computer.



Used to measure resolution.



To create an editable image file (.PCX or .TIF) from a fax file (.QFX or .REC).



The transmission of an image of a document over telephone lines.



A hardware device which has the capabilities of a modem and has the additional capability of transmitting 
(and/or receiving) faxes to other fax machines or fax/modems.



The name given to a DOS file.



The DOS directory in which the QuickLink program files (.EXE and .DLL) are located.



To create a faxable    file (.QFX or .REC) from a non-faxable image file.



To put the QuickLink software onto your computer system.



The program used to install QuickLink.    The name of the executable program is INSTALL.EXE.



A unit of measurement consisting of 1,024 bytes.



The list of menus displayed on your screen when you start QuickLink.



A unit of measurement consisting of 1,024 Kilobytes.



A set of classes which defines error correction and data compression which can be used with modem to 
modem connections.    This protocol is an industry de facto standard developed and licensed by 
Microcom, Inc.



A hardware device which translates digital information from a computer into analog information which can 
be transmitted over a phone line.    It also can take analog information from the phone line and convert it 
to digital signals.



The text file editor that is run from QuickLink.    This file is named NOTEPAD.EXE.    This program is 
shipped with every copy of Windows.



The process by which text in a fax file is recognized and converted to a file which can be understood and 
edited by a word processor.



A pre-defined number of bytes in a file transfer.    A file transfer is a stream of data packets.



To send the text scrap to the modem.



Refers to the 5 different consecutive parts of the T.30 handshake.
Phase A - setting up the call
Phase B - the pre-message procedure and selecting facilities (handshaking)
Phase C - image transmission 
Phase D - post-message procedure including end of page confirmation
Phase E - call release



A method of data transmission.    Different protocols use different methods to transmit data.



A method of dialing phone numbers using mechanically generated pulses.    Rotary telephones use pulse 
dialing.



An entry in the Data Phone List or the Fax Phone List.



The density of dots on an image or on screen, measured in dots per inch.    High resolution faxes are 200 
by 200 dots per inch, and normal resolution faxes are 200 by 100 dots per inch.



A type of hardware flow control.    The RTS signal indicates to the modem that the computer can accept 
data.    The CTS signal indicates to the computer that the modem can accept data.



A one horizontal line of a fax image.    On a high resolution fax there are 2200 scan lines per fax.    On a 
normal resolution fax there are 1100 scan lines per fax.



The CCITT specification which defines the procedures and signals to be used between facsimile 
equipment.    This is often referred to as the fax "handshaking."



The CCITT specification which defines the coding scheme used for image data in a fax transmission.    
Data compressed in this manner is what is transmitted over phone lines during a fax.



Dialing phone numbers using electronically generated tones.    Push-button telephones often use tone 
dialing.    QuickLink defaults to tone dialing.



The process of sending a data or program file to a remote computer.



A standard developed by CCITT which defines error correction and data compression which can be used 
with modem to modem connections.



A type of software flow control.    An XOFF character (ASCII character 19) is sent over the line if the 
receiver wants to temporarily stop data transmission.    An XON character (ASCII character 17) is sent to 
continue the data transmission.





How To:

These topics show you how to perform commonly used functions of QuickLink:

How to send a fax from QuickLink
How to send a fax from within a Windows program
How to receive a fax.
How to send a data file.
How to receive a data file.



How To Send a Fax
This section explains the steps involved in sending a fax to another fax machine or fax modem.

1. Before we can send a fax, we must create something to send.    Pull down the Edit menu and 
select Run Notepad.    Windows Notepad must be installed on your system for this exercise.

2. You may type in anything you wish in the Notepad window.    Type in a few lines of text.

3. Pull down the File menu and select Save.

4. Type C:\TEST.TXT in the File Name field and click the OK button.

5. Pull down the File menu again and select Exit.

6. Pull down the Fax menu of QuickLink and select Send Fax.

7. In the File Specification field type C:\*.TXT and press RETURN.    The Files Available list box will 
change to reflect the new file specification.    You should see the file, TEST.TXT in the list.

8. Locate the file TEST.TXT in the list of files available and double-click on the file name.

9. The Document Type selection box will appear asking you what kind of document it is.    Select 
TEXT and click the OK button.    The file will appear in the list of Files Selected.

10. Click on the OK button.    The Send Fax Information box will appear.

11. Enter the proper text in the Phone, Name and Attention fields.

12. Click the Send Fax button.    QuickLink will then convert the document to fax format and    the Fax 
Manager will appear showing you the status of the transmission.

13. You can monitor the status of the transmission or switch to another application if you wish.



How To Send a Fax From Within a Windows Program
The most convenient way to send out a fax is to do it directly from your Windows programs.    The benefits
of sending out faxes in this manner are that there is no need to interrupt your work to fax out and that all 
of your fonts, graphics, and formatting are incorporated; You get true WYSIWYG faxing!

1. Before we can send a fax, we must create something to send.    Pull down the Edit menu and 
select Run Notepad.    Windows Notepad must be installed on your system for this exercise.

2. You may type in anything you wish in the Notepad window.    Type in a few lines of text.

3. Pull down the File menu located on Notepads menu bar and select Print Setup.

4. In the Print Setup Dialog, choose the Quick Link on FAX/MODEM print driver from the drop 
down list of print drivers.    Select OK to close the dialog.

5. Pull down Notepads File menu again and select Print.    This will cause Notepad to print to the 
QuickLink Fax Driver.

6. The QuickLink Fax Driver will pop up the Send Fax Dialog.    Fill in the Phone field with a fax 
number and press OK.    There will be a small pause while Notepad prints the fax.    Next you will 
see the Fax Manager loaded, if it was not already, and it will begin sending the fax which you just 
printed.



How To Receive a Fax
This section explains the steps involved in receiving a fax from another fax machine or fax modem.

1. First, lets set up a few options in QuickLink.    Pull down the Setup menu and select Receive Fax 
Setup.

2. You will see two options, Enable fax receiving at Fax Manager startup and Run Fax Manager 
maximized.    If either of those two items are unchecked, place a check in the box next to them by 
clicking on the box.    Then click on the OK button.

3. Pull down the Fax menu and select Load Fax Manager.    If the Fax Manager is already loaded, 
the menu option will say Unload Fax Manager.

4. The Fax Manager status box will appear in the lower right hand corner of the screen indicating 
that it is waiting for a call.    The Fax Manager is now ready to receive.

5. Have someone send a fax to you.    When the fax comes in, the status of the transmission will be 
displayed in the Fax Manager window as the fax progresses.    The fax will be stored in the 
directory you have specified as the InBox.

6. We can now take a look at the file.    Pull down the fax menu and select View Fax Log.    Then 
select the Receive Log.

7. The fax just received will be the first on in the list.    To view the fax simply double-click on the 
entry.    This will launch the Fax Viewer and load in the fax for viewing.

8. Receiving faxes can be done entirely in the background while you are running other applications.  
Just make sure the Fax Manager is loaded and Fax Receiving is enabled and your ready to 
receive.



How To Send a Data File
This section explains the steps involved in sending a data file to another computer.    Sending a data file is
also known as uploading.

1. First, a connection must be made between two computers.    For this exercise, we'll connect to the
Smith Micro Software, Inc. BBS (Bulletin Board System), American Email.    Pull down the 
Connect menu and select Phone List.    Then double-click on the American E-Mail entry.

2. QuickLink will then dial the American E-Mail computer.    If the connection is made, you will see a 
CONNECT message appear in the dialer dialog box.

3. If you have connected to American E-Mail before, enter your ID and password.    Otherwise type 
the word NEW.    If you are a new user, you must enter information about yourself in the sign-up 
process.    Enter all the necessary information when prompted.    When sign-up is complete, you 
will be placed at the main menu.

4. From the main menu, hit the L key and press RETURN to switch to the Library of Files.

5. Hit the U key and press RETURN to select the uploading    process.

6. Type in a valid DOS file name for the file to upload and press return.    This can be any valid file 
name.    If the file already exists on American E-Mail, you must reenter a different name.    The 
name does not need to be the same as the name of    the file we will be sending; Pick any random
name.

7. Hit the C key and press RETURN to select the Xmodem CRC transfer protocol.

8. American E-Mail is now ready to receive the file.    You must setup QuickLink to send the file now. 
Pull down the File menu and select Send File.

9. Select Xmodem CRC transfer protocol.    Since this is the protocol that was selected on American
E-Mail, we must select it here also.

10. We must now select a file to send.    For this exercise we'll send one of the QuickLink script files, 
EMAIL.SRP.    Type in EMAIL.SRP in the File field and click on the OK button.    You must be 
located in the subdirectory where QuickLink is stored in order to access this file.    If you are 
located in another subdirectory, either switch to the QuickLink directory or you must give the full 
path name of the file.

11. The file will then start to transfer.    This is a very small file and should take about 10 or 15 
seconds.    When the transfer is done, a Transfer Complete dialog box will appear.    Click on the 
OK button.

12. Hit the N key and press RETURN when asked if you would like to edit the file description.

13. This concludes the operations involved in sending a data file.    You are still connected to 
American E-Mail so you may want to browse around.    When you are ready to log off, pull down 
the Connect menu and select Hangup.



How To Receive a Data File
This section explains the steps involved in receiving a data file from another computer.    Receiving a data 
file is also known as downloading.

1. First, a connection must be made between two computers.    For this exercise, we'll connect to the
Smith Micro Software, Inc. BBS, American E-Mail.    Pull down the Connect menu and select 
Phone List.    Then double-click on the American E-Mail entry.

2. QuickLink will then dial the American E-Mail computer.    If the connection is made, you will see a 
CONNECT message appear in the dialer dialog box.

3. If you have connected to American E-Mail before, enter your ID and password.    Otherwise type 
the word NEW.    If you are a new user, you must enter information about yourself in the sign-up 
process.    Enter all the necessary information when prompted.    When sign-up is complete, you 
will be placed at the main menu.

4. From the main menu, hit the L key and press RETURN to switch to the Library of Files.

6. Press the D key and press RETURN to activate the downloading procedure.

7. Type SMSILOGO.QFX and press RETURN.

8. Hit the C key and press RETURN to select the Xmodem CRC transfer protocol.

9. American E-Mail is now ready to send the file.    QuickLink must now be set to receive the file.    
Pull down the File menu and select Receive File.

10. Select Xmodem CRC as the transfer protocol.    Since this is what we selected on American E-
Mail, we must select it here also.

11. Now you must enter the name to store the file as on your disk.    Enter WINTEST.QFX in the File 
field and click on the OK button.

12. QuickLink will now start receiving the file.    When the transfer is complete, a dialog box will 
appear stating that the transmission is complete.    Click on the OK button.

13. The file is now located on your disk as WINTEST.QFX.    This is a sample fax file that may be 
viewed using the Fax Viewer.

14. This concludes the operations involved in receiving a data file.    You are still connected to 
American E-Mail.    You may want to browse around and possibly download another file.    When 
you are ready to log off, pull down the Connect menu and select Hangup.





Send File
Receive File
Capture Text
Print...
Printer Setup...
Exit



Copy All
Paste To Host
Run Notepad...
Clear Screen
Start/Stop Timer
Reset Timer
Button Bar
Status Bar



Line Settings...
Modem Setup...
Terminal Options...
Connection Setup...
Send Fax Setup...
Receive Fax Setup...
Cover Page Setup...
Services Setup...
Macro Keys...



On-Line...
Dial...
Hangup
Send Break
Phone List...
Run Script...
CompuServe
DowJones
GEnie



Send Fax...
Fax Phone List...
Send Faxes On Hold
Load/Unload Fax Manager
Fax Receiving
Manual Fax Receive
Convert Documents
View Fax Document
View Fax Log
View Fax Schedule...





Screen Color Setup

The Screen Color Setup Dialog sets colors for the terminal screen.

Colors can be selected for the foreground and background text colors for the normal text of the terminal 
screen.    For text that comes in with the blinking attribute, you may either select foreground and 
background colors for the blinking text or use the colors that come in but use italics to distinguish the text 
from normal text.    The italics option is suggested.    An example of the colors is displayed at the bottom of
the dialog.



VT100 Terminal Setup
The VT Terminal Setup Dialog sets options for the VT100/102 terminal emulator.

VT100 supports the following options:

New Line Mode

Translates carriage returns to carriage return - line feed pairs.    If New Line Mode is enabled, 
carriage return characters (ASCII 13) received from the remote computer will be translated to 
carriage return - line feed combinations (ASCII 13, ASCII 10).    With this option off, carriage 
returns will remain intact.

Answer Back Message

The Answer Back Message is used to hold a text message that will be transmitted when the 
remote computer requests it.    Some host computers require you to have a log in ID in the 
Answer Back Message so that it can log you in automatically when you connect.    The text you 
must enter will vary between systems.    You should find out from the host computer what should 
be placed in this box or if you should place anything into it at all.

Tab Stops

Sets the column positions for each tab character for display on the terminal window.    These are 
tab characters that are sent from the remote computer.    The default for tab stops are every 
eighth column.    When entering the tab positions, all numbers must be separated by commas.



Send Fax Dialog

The Send Fax Dialog is used to indicate information about when and where a fax is to be sent.

This dialog is the same when you are sending from the QuickLink main application or the QuickLink Fax 
Driver from within another application.    The only exception is the Save To File button which only appears
when using the Fax Driver.

Note:    If your Window Background color is set to be the same as your Disabled Text color in the 
control panel some of the Phone, Name, etc. field entries may appear to disappear when Manual Send 
is checked or Modify (and then OK) is pressed.    They have not disappeared, but are only grayed out.    
You may change either the Window Background or Disabled Text colors via the control panel to make 
those disabled fields visible.

Phone

The phone number to which the fax will be sent.

Name

Sets the name to which the fax is being sent.

Attention

Defines an attention field for the fax.

Prefix

A dialing prefix, if any, that should be used before dialing the actual phone number.    This could 
be a credit card number or a number that is required to get an outside phone line in your 
company.

Manual Send

A fax can be sent without entering the phone number in the phone field.    Manual Send can be 
invoked by selecting the Manual Send check box or placing the letter M in the first position of the 
phone field.    Instead of dialing a phone number, QuickLink will prompt you to dial the number 
manually..

Add



Automatically adds a new record to the phone list with the Company, Attention, and Phone fields.

Phone List

Accesses the fax phone list.

Schedule

Sets the date and time at which the fax should be transmitted.    The date and time are defaulted 
to the current date and time so that the fax will be sent immediately.

To change the date or time, click on the number you wish to change and then you may either type
in the new number manually or you may use the up and down arrow buttons.    For example, if 
you would like the fax to be sent at 11:00 PM, first click on the hour in the time field and use the 
arrow buttons to change the number to 11.    Then click on the minute and change that number to 
00.

Hold For Later

Rather than indicate a specific date and time for the fax to be sent, you may check the Hold For 
Later option which will place the fax on hold.    To send the fax at a later time, either reschedule 
the fax from the Fax Schedule, or choose the Send Faxes On Hold menu option from the Fax 
Menu.

Cover Page

Enables the sending of a cover page along with the fax.    If you would like a cover page sent 
along with your fax, check this option.

Cover Page Modify

Allows you to modify the fields in the cover page.    The cover page fields may be changed to 
differ from the normal entry fields for Company, Attention and Phone.    This allows you to type the
Company, Attention and Phone fields.    Add them to the phone list.    Then go back and modify 
them for this transmission only.

Save To File (Only when using the QuickLink Fax/Print Driver)

Saves the printed output to a QFX file instead of sending the fax out.

Related Topics:

Modify Cover Page
Fax Phone List
View Fax Schedule
How To Send A Fax



Modify Cover Page

The Modify Cover Page Dialog allows you to modify the fields of the fax cover page for the current send.
You can modify the Name, Company, and Fax Phone number fields.

In addition you can add a free-form note.    Any text can be typed into the Note field.    Your message has 
a maximum length of approximately 900 characters (about 200 words).    If a larger note is required, you 
should create it in an ASCII text file and include it as one of the documents in the fax transmission.



Document Type Selection

The Document Type Selection Dialog asks you to select the type of document that QuickLink is to 
convert.

When QuickLink needs to convert a document to a fax (*.QFX) format, it will ask you for original 
document format.    It will only ask you if it does not recognize the format.

Select the format of the original document,    Valid types are ASCII Text, BMP, TIFF, PCX, DCX and 
MacPaint.    If your document is not one these types, it will not convert correctly.

NOTE:    Do not confuse word processor documents with ASCII Text files.    ASCII Text files do not contain 
any formatting in them at all.    An example of an ASCII Text file would be a file created in Windows 
Notepad.



Open File
All file open dialogs in QuickLink use the standard Windows common dialogs interface.    For a description
of these dialogs, refer to your Windows documentation.



Open File
All file open dialogs in QuickLink use the standard Windows common dialogs interface.    For a description
of these dialogs, refer to your Windows documentation.



InBox Setup

The InBox Path Setup Dialog indicates where QuickLink should store received faxes.

QuickLink can store received faxes anywhere on your disk that you like.    Only drives and directories will 
be displayed in the list box.    Select the location you would like your received faxes to be located.

NOTE:    It is highly recommended that you do not receive faxes to a floppy drive.    Faxing is a very timing
sensitive operation and due to the slowness of a floppy drive, it could cause serious problems in 
receiving.

Related Topics:

QuickLink Outbox



OutBox Setup

The OutBox Path Setup Dialog indicates where QuickLink should store outgoing faxes.

QuickLink can store outgoing faxes anywhere on your disk that you like.    Only drives and directories will 
be displayed in the list box.    Select the location you would like your outgoing faxes to be located.

NOTE:    It is highly recommended that you do not send faxes from a floppy drive.    Faxing is a very timing
sensitive operation and due to the slowness of a floppy drive, it could cause serious problems in sending.

Related Topics:

QuickLink Inbox



Multiple File Selections

All file open dialogs in QuickLink use the standard Windows common dialogs interface.    For a description
of these dialogs, refer to your Windows documentation.



Add/Edit Phone List Entry
The Data Phone List - Add/Edit Dialog adds or edits and entry in the Data Phone List.

Entries in the phone list can be set up to automatically change various settings when dialing such as baud
rate and terminal type.    A script can even be run automatically.

Enter the name and phone number to dial for this entry.    You may set up the baud rate, terminal type, 
data bits, parity and stop bits for connecting to this computer.

If you would like to automatically run a script when you dial the computer, check the Script box and type 
in the name of the script to run.    Scripts are useful for entering passwords and IDs automatically.

Related Topics:

Modem Line Settings
Terminal Options
Run Script
Script Language Reference



Add/Edit Fax Phone List Entry
The Fax Phone List - Add/Edit Dialog adds or edits an entry in the Fax Phone List.

Four fields can be entered for each record in the fax phone list:

Name Name of recipient.    Limited to 40 characters
Company Name of recipients company.    Limited to 40 characters
Fax Phone # Fax phone number.    Limited to 40 characters
Group Fax group for the phone list entry.    Limited to 1 character



Auto Detect Modem

The Auto Detect Modem Dialog allows you to manually select the COM port to use or will poll each 
COM port in search of a modem.

You can manually select the desired COM port to use with your modem or you can let QuickLink 
automatically check each COM port for an available modem

To let QuickLink find the modem for you, select the Auto Sense button and click OK.    Otherwise, click on 
the desired COM port and click OK.

Related Topics:

Select Available Modem



Select Available Modem

The Select Modem Dialog allows you to select the COM port to use if QuickLink has found more than 
one modem on your system.

Select the desired COM port to use.

Related Topics:

Auto Detect Modem



Select Page Range

The Print Dialog allows you to select the page range and number of copies to print.

When printing text or fax files from QuickLink, you may specify the number of copies to print and the page
range for printing.

Enter the number of copies to print.

Select the page range of the document to print.    If you would like to select a specific page range, click on 
the Pages radio button and then enter the From and To pages.



Log Report Type

The Print Fax Log Dialog allows you to select the type of log report to be printed.

When printing the send or receive fax logs, either a summary or a complete report may be generated.    
Select the type of report to print by clicking on the desired item and then click the Print button.

The complete report includes all information found in the log.

The summary report includes the fax name, the document sent, the status of the transmission, the 
duration and the date and time.    The summary report of the send log also includes the total duration of all
the calls.    This is very useful for estimating phone charges.



User Registration
The User Registration Dialog is used to automatically register your modem with the modem 
manufacturer.

Begin by filling in all the registration information.    Certain versions of QuickLink will have a More button 
which will pop up other dialogs with additional registration questions.

Pressing Register Now after filling in the user registration information will call up the manufacturer of your
modem and automatically register your modem with the company.    Pressing Save For Later will allow 
you to save the information you have entered and let you continue at a later time.



The Terminal Window is where communication with your modem takes place.    Characters coming from 
the modem are displayed here, as well as characters which are sent to the modem by typing at your 
keyboard.



QuickLink Fax Driver
The QuickLink Fax Driver is used to print a fax from within an application other than QuickLink.    By 
printing to the QuickLink Fax Driver, the document is converted into a fax file and the Send Fax Dialog is
activated allowing you to indicate where and when the fax is to be sent.    When the application is done 
printing, the Fax Manager is started, and you will see the fax being sent.

Please see How to send a fax from within a Windows program for more detailed help.





QuickLink Fax Viewer
The QuickLink Fax Viewer is used to view a fax.    It allows you to view the fax in a number of sizes and 
positions.    Use the menu to manipulate the fax for viewing.    The Button Bar also provides easy access 
to all the features of the QuickLink Fax Viewer.    Buttons that are dimmed are not available for use at that 
time.    The Status Bar displays information about the fax currently being viewed.

Click on an area of the picture above to receive help about that portion of the QuickLink Fax Viewer.



Open...
Print...
Printer Setup...
Exit



Button Bar



Normal View
Fit Vertical
Fix Horizontal
Zoom In
Zoom Out
Grabber
Next Page
Last Page
Previous Page
First Page



Flip Page
Inverse Page



Open Fax File

    Opens a fax file for viewing.    The QuickLink Fax Viewer uses the standard Windows Open File 
Dialog.

Only QuickLink fax files (*.QFX, *.REC) can be viewed in the QuickLink Fax Viewer.



Print Fax File

    Prints the fax file being viewed.

Related Topics:

Printer Setup



Printer Setup
Allows you to select the print driver that QuickLink will print to.    Select the correct driver from the list that 
corresponds to your printer.

Related Topics:

Print Fax File



Exit Viewer
Exit the QuickLink Fax Viewer and return to the previously running task.

If the QuickLink Fax Viewer was invoked from within the main QuickLink application, you will return to that
application after exiting.    Otherwise, you will be returned to the previously running task.



Show/Hide Button Bar
Shows or hides the Button Bar.

Select the Button Bar option from the edit menu to show the Button Bar.    A check mark will be placed 
next to the menu option indicating that it is active.    To turn off the Button Bar, select the option from the 
menu once more.



Fit Fax Vertically

    Displays the currently viewed fax page so that the entire height of the page can be viewed.



Fit Fax Horizontally

    Displays the currently viewed fax page so that the entire width of the page can be viewed.



Normal Fax View

    Displays the currently viewed fax page in normal size.



Zoom In

    Zooms in on an area of the fax page.

When Zoom In mode in effect, the cursor will change to a magnifying glass allowing you to select the area
to be enlarged.    Place the cursor on the area you wish to magnify and click the left mouse button.



Zoom Out

    Zooms out on an area of the fax page.

When Zoom Out mode in effect, the cursor will change to a magnifying glass allowing you to select the 
area to be zoomed out.    Place the cursor on the area you wish to zoom out and click the left mouse 
button.



Grabber

    Allows the fax to be moved within the viewer window.

When grabber mode is in effect, the cursor will change to a hand allowing you to select the area of the fax
to be moved.    Place the hand on the area, click and hold the left mouse button and drag the fax to the 
new position.    Then release the mouse button.



View Next Page

    Displays the next page of the fax.



View Previous Page

    Displays the previous page of the fax.



View First Page

    Displays the first page of the fax transmission.



View Last Page

    Displays the last page of the fax transmission.



Flip Fax Horizontally

    Flips the fax page horizontally.



Invert Page

    Inverts the fax page so that the foreground color becomes the background color and the 
background color becomes the foreground color.



Viewer Status Bar
Displays information pertaining to the viewed fax.

The Viewer Status Bar displays important information about the fax being viewed.    From left to right, the 
items displayed are: the fax file being viewed; the current zoom factor; the page being viewed and the 
total pages in the document; the current view mode.





ASCII File Transfer Protocol
The ASCII file transfer protocol is for sending basic DOS text files.    DOS text files do not have any 
formatting within them as with a word processor.    For example, documents created in Windows Notepad 
are ASCII text files.    Documents created in Windows Write are not ASCII text files.

The ASCII transfer provides for no error correction.    If line noise distorts the data, it will not match the file 
as it was sent.    In many cases, the distortion will be obvious and may be edited using any ASCII text 
editor.

Related Topics:

How to send a file
How to receive a file



Kermit File Transfer Protocol
The Kermit transfer protocol was primarily designed for data transfers to and from mainframe style 
computers.    Kermit    is a batch transfer protocol that allows multiple files to be sent at the same time.    
The Kermit protocol sends data in very small packet sizes which will decrease transfer speed.

Related Topics:

How to send a file
How to receive a file



Super Kermit File Transfer Protocol
Super Kermit is a useful protocol for transferring and receiving data over data networks such as Telenet 
and Tymnet.    These networks have long communication delays that significantly degrade the 
performance of file transfers.    Multiple packets of information are sent at one time which help overcome 
the delays on the data networks.

Super Kermit also has a simple data compression ability that increases transfer performance.

Related Topics:

How to send a file
How to receive a file



Xmodem File Transfer Protocol
The Xmodem transfer protocol, also known as Xmodem Checksum, is one of three Xmodem type transfer
protocols.    In all of the Xmodem type protocols, data must be sent using the line settings, 8 data bits, 1 
stop bit and no parity.    If the line settings are set to anything other than this, they will automatically be 
changed during the transfer.

Xmodem sends data in a smaller packet size (128 bytes) and uses a checksum method of error 
correction.    The checksum method compares two computations, one calculated by the sending computer
before a packet is sent and one calculated by the receiving computer after the packet is sent.    If these 
numbers match, the data was assumed to be transferred correctly.    This method provides for a high 
degree of error correction, but it is not impossible for an error to go undetected.

Related Topics:

Xmodem-1K File Transfer Protocol
Xmodem-CRC File Transfer Protocol
How to send a file
How to receive a file



Xmodem-1K File Transfer Protocol
Xmodem 1K is very similar to Xmodem Checksum with the exception that it send packets of data 1K 
(1024 bytes) at a time.    Provided that no errors are detected, Xmodem 1K will send the data in 1K 
packets for as long as possible.    The increase in packet size, boosts performance over the standard 
Xmodem Checksum.

Xmodem 1K is, in essence , the same protocol as Ymodem.    Ymodem, however, has the ability to send 
multiple files at one time where Xmodem 1K can send only one at a time.

When sending data using the Xmodem 1K protocol, if the receiving computer does not support this 
protocol,    QuickLink will fall back to the Xmodem CRC protocol, which in turn will fall back to the 
Xmodem Checksum protocol if the receiving computer does not support    the Xmodem CRC method 
either.

Related Topics:

Xmodem-File Transfer Protocol
Xmodem-CRC File Transfer Protocol
Ymodem-File Transfer Protocol
How to send a file
How to receive a file



Xmodem-CRC File Transfer Protocol
Xmodem CRC is the best error correcting protocols of the Xmodems.    It replaces the Checksum error 
correcting method with a CRC (Cyclic Redundancy Check).    This change provides a 99.9984% 
assurance of detecting any transmission errors.    With the checksum method, it is possible for 1 out of 
256 bad data packets to go undetected.    With the CRC method, the possibility for a bad packet to go 
undetected drops to 1 in 700 billion.

When sending data using the Xmodem CRC protocol, if the receiving computer does not support this 
protocol,    QuickLink will fall back to the Xmodem Checksum protocol.

Related Topics:

Xmodem-File Transfer Protocol
Xmodem-1K File Transfer Protocol
How to send a file
How to receive a file



Ymodem File Transfer Protocol
Ymodem transfer protocol is very similar to the Xmodem 1K protocol in that it sends 1k (1024 bytes) of 
data in each data packet.    Ymodem, however, can send multiple files at one time.    This is also known as
a batch transfer.

Some programs, such as older versions of Procomm, incorrectly call Xmodem 1K, Ymodem.    Others call 
Ymodem, Ymodem Batch.    When sending data to a computer using Procomm, you will need to select 1K
Xmodem while the user of Procomm application selects Ymodem.

Related Topics:

Ymodem-G File Transfer Protocol
Xmodem-1K File Transfer Protocol
How to send a file
How to receive a file



Ymodem-G File Transfer Protocol
Ymodem-G is a multiple file transfer protocol.    Ymodem-G was designed for modems that have error 
correction built in such as modems that include MNP (Microcom Networking Protocol).    Ymodem-G does 
not have any error correction during the transmission.    If you do not have an error correcting modem, you
do not want to use Ymodem-G.

Multiple files may be sent or received at one time with Ymodem-G.    Along with the data that is sent 
during the transmission, Ymodem-G sends information regarding the filename, file attributes and creation 
date of the files.

Related Topics:

Ymodem-File Transfer Protocol
How to send a file
How to receive a file



Zmodem File Transfer Protocol
Zmodem transfer protocol sends variable size data blocks, depending on line condition.    Zmodem can 
send and receive multiple files at one time.    It also allows automatic file reception and sends file names, 
sizes, and creation dates. Both 16- and 32-bit error checking are available. Interrupted data transmissions
can be resumed from the point at which they were interrupted.

Zmodem is a relatively new protocol and there are variations in its implementation by different software 
vendors. If you have problems with Zmodem, try Ymodem or Xmodem.

Related Topics:

How to send a file
How to receive a file



Compuserve B/B+ File Transfer Protocol
The Compuserve B/B+ transfer protocol allows for automatic batch file transfers between your local 
computer and Compuserve.

Related Topics:

How to send a file
How to receive a file
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Getting Started
QuickLink is a fax and data communications package all in one.    Faxes can be sent    and received 
entirely in the background from within the main QuickLink application or any other Windows application.

If you are unfamiliar with the Windows environment, please refer to the Getting Started section of the 
WINHELP.HLP help file.

QuickLink consists of three applications.    The main QuickLink application, the Fax Manager and the Fax 
Viewer.    The Fax Manager is responsible for all fax transmissions.    Faxes can be viewed or printed 
using the Fax Viewer.    During installation of QuickLink, a group will be created in the Program Manager.   
Below are the three icons that are placed in the QuickLink group and what they are.

Main QuickLink application.

Fax Viewer.

Fax Manager.

The Fax Manager has four basic idle states.    Waiting for an incoming call,    scheduled faxes waiting to 
go out, waiting for an incoming call and faxes scheduled to go out, or just simply idle.    When the Fax 
Manager is loaded and iconized, it will appear on your desktop with the following icons:

Idle

Faxes scheduled to be sent.

Ready to receive a call.



Faxes schedule to be sent and also ready to receive a call.

The Fax Manager contains a feature called ModemMonitor.    The ModemMonitor is a panel of status 
lights simulating the status lights of an external modem.    The ModemMonitor and the percentage bar of 
the Fax Manager occupy the same space.    You can toggle between these two options by clicking the left 
mouse button on the percentage bar or ModemMonitor.





Script Language Reference
Below is a list of the commands in the QuickLink Script Language.

Baud Statement:

This statement allows you to specify the baud rate to be used when the script file is executed.

Format: Baud "rate"

"Rate" can be set to 110, 150, 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 
115200.

Clearstring Statement:

This command will clear the contents of the special variable called InString.    This variable is 
created by the use of the second form of the In Statement defined below.

Format: Clearstring

CLS Statement:

This command will clear the Terminal Window and has the same effect as selecting Clear Screen 
on the Edit Menu.

Format: CLS

The CLS statement will not impact the contents of the Line Buffer.

Data Statement:

This statement is used to specify the number of data bits, either 4, 5, 6, 7 or 8 to be used during 
the execution of the script.

Format: Data "#"

Where # is either 4, 5, 6, 7 or 8.

Dial Statement:

This command will instruct QuickLink to dial a specified telephone number.

Format: Dial "xxx-xxxx"

Where xxx-xxxx is the telephone number to be dialed.    QuickLink will use the dialing prefix 
defined on the Modem Setup Dialog Box.    You must have an AT command set compatible 
modem and have English Responses set on to use this statement.

Example: Dial "1-714-362-5822"

The example above would instruct QuickLink to dial the Smith Micro Software support BBS.

Echo Statement:

This command will cause a literal string that follows the command to be displayed in the local 



Terminal Window.

Format: Echo "xxxxxx"

Where xxxxxx is a literal string to be echoed to the Terminal Window.    The string must be 
enclosed by double quotes.

Example: Echo "This is a sample string"

The string, This is a sample string, will be displayed in the local Terminal Window.

End Statement:

This command is used to mark the logical end of a set of script commands.

Format: End

Execution of the script instructions is halted upon encountering an END command.

Goto Statement:

This command will transfer the execution to a specified procedure name.

Format: Goto Procedure:

Where Procedure: is the name of a procedure defined in the script file.    The procedure name 
must end with a colon.    The following script code shows the use of the GOTO statement.

Example Start:
Echo "This is an example"
Goto Step2:
Step1:
End
Step2:
Goto Step1:

If you follow the execution of the script above, the last procedure executed is Step1: that 
terminates the script with the END Statement.

If Statement:

The If Statement allows you to test the contents of a special variable called InString.    InString is 
created by using the second form of the In Statement defined below.

Format: If InString = "xxxxxxx" Goto Procedure:

Where xxxxxxx is a literal string not longer than 40 characters.    If InString equals the specified 
literal string then execution is transferred to the procedure specified in the Goto.

Example: If InString = "Password" Goto Step2:

In Statement:

There are two forms of the In Statement.    The first form of the statement will cause QuickLink to 
wait "n" seconds for string of characters to be received from a remote computer.



Format: In "xxxxxx"    n

Where xxxxxx is a string for which you want QuickLink to wait.    QuickLink will wait up to "n" 
seconds for a message to be received from a remote computer.    If after waiting "n" seconds, the 
string is not received, the remainder of the commands in the script file will be bypassed.

Example: In "Password?" 30

QuickLink will wait 30 seconds for the string, Password?, to be received from the remote 
computer before continuing with the execution of the script.

The second form of the In Statement allows you the capability to receive one character at a time 
from your modem.    Each character will be added to a special buffer called InString.

Format: In InString

InString may contain up to 40 characters of input and will generate an error if more than 40 
characters are received.    InString may be used in an If statement for testing and controlling the 
flow of the script execution.

Out Statement:

This command will cause a string to be transmitted to a remote computer.

Format: Out    "xxxxxx"

Where, xxxxxx is a string to be transmitted to a remote computer.

Example: Out "DEMOPASS\r"

QuickLink will transmit the string, DEMOPASS, to the remote computer followed by a Return 
character (\r).

Pause Statement:

This statement will cause the execution of a script file to be temporarily halted until the user 
presses a key on the keyboard.

Format: Pause

A message will be displayed in the terminal window, instructing the user to Press a Key to 
Continue.

Parity Statement:

This statement is used to specify the parity to be used during the execution of the script.

Format: Parity "x"

Where, x is "N" for none, "O" for odd, "E" for even, "M" for mark, and "S" for space parity.

RtsCts Statement:
This statement is used to specify whether the RTS/CTS hardware flow control is to be used when 
executing this script.



Format: RtsCts "xx"

Where xx is "ON" for on or "OFF" for off.

Stop Statement:

This statement is used to specify the number of stop bits, either 1, 1.5 or 2 to be used during the 
execution of the script.

Format: Stop "#"

Where # is either 1, 1.5 or 2.

Until Statement:

This command will cause QuickLink to wait until a specified time before continuing with the 
execution of the script.

Format: Until "hh:mm"

  The time must be specified in the form of    24 hour military time.

Wait Statement:

This command will cause QuickLink to delay for 'n' seconds before proceeding with the next script
command.

Format: Wait n

Where 'n' is the number of seconds you want QuickLink to wait before proceeding to the next 
script command.

Example: Wait 15

QuickLink will wait 15 seconds before executing the next step in the script file.

XonXoff Statement:

This statement is used to specify whether the Xon/Xoff flow control is to be used when executing 
this script.

Format: XonXoff "xx"

Where xx is "ON" for on or "OFF" for off.

In addition to the above script commands, the QuickLink script language includes a number of predefined 
variables that may be used in writing a script.    Many of these variables are used by QuickLink to provide 
automatic connection to Compuserve, Dow Jones and GEnie.    The following list of variables are included
in the script language:

Variable Meaning
Compunet Telephone number for CompuServe's own network
Telenet Telephone number for Telenet
Tymnet Telephone number for Tymnet
Cacct CompuServe account number



Cpass CompuServe password
Dpass Dow Jones password
Guser GEnie user number
Gpass Genie password





Configure Line Settings
The Line Settings option in the Setup Menu sets up communication port line settings.

Baud Rate

Set the correct baud rate for your modem.    Any baud rate from 110 to 115200 may be selected, 
provided the rate is supported by the modem.

Data Bits

Set the correct data bits required for the communications session.    Connections to personal 
computers will normally use 8 data bits.    Connections to larger mainframe style computers will 
normally use 7 data bits.    Data bits may be set from 4 to 8.

Parity

Set the correct parity required for the communications session.    Connections to personal 
computers will normally use no parity.    Connections to larger style mainframe computers will 
normally use even parity.

Stop Bits

Set the stop bits required for the communication session.    The most common stop bit setting is 1.

Flow Control

Flow control is the method of regulating data as it is sent over the modem.    RTS/CTS is the more
common of the controls.    RTS/CTS should only be used with high speed data modems that have 
flow control built into the modem.    XonXoff flow control is an older method of flow control that is 
not in use much today.



Distinctive Ring Settings
If your modem has distinctive ring capabilities, QuickLink may be able to take advantage of them.    If so, 
the Distinctive Ring dialog allows you to determine what action QuickLink will take for each ring type.    
The choices for each ring type include:

Ignore Ring Never answer
Fax Only Answer but only respond to fax calls
Data Only Answer but only respond to data calls
Fax & Data Answer and respond to both fax and data calls

Unless you select Ignore Ring, the call will always be picked up for that ring type, and a detection tone will
be emitted to the caller.



Configure Terminal Settings
The Terminal Options option in the Setup Menu allows you to setup how QuickLink displays itself and 
its terminal window.

Local Echo

Local echo enables QuickLink to echo characters to your terminal window.    If characters that you
type do not appear on your screen, enable local echo.

CR->CR/LF (Inbound)/(Outbound)

Translates carriage return characters (ASCII 13) to a carriage return-line feed (ASCII 10) 
combination.

Line Wrap

Wraps lines in the terminal window.    Characters will wrap to the current width of the window.

Destructive Backspace

Erases characters when the backspace key is pressed.    If Line Wrap is off, the cursor will be 
moved to the previous character but it will not be erased.

Show Button Bar

Enables the button bar at the top of the terminal window.

Show Status Bar

Enables the status bar at the bottom of the terminal window.

On-Line At Startup

Instructs QuickLink to open the terminal window when the program is started.

Off-Line At Hangup

Instructs QuickLink to close the terminal window when a data connection is terminated.    This will 
only occur if the connection is terminated by selecting Hangup from the Connect menu.

Re-Dial On Busy



Enables re-dialing when a busy signal is detected by the modem.

Auto Baud

Allows QuickLink to automatically adjust to the baud rate of the called modem.

Terminal Emulator

Allows QuickLink to act like various terminal types.    Available terminal emulators are TTY, 
VT100, ANSI, VT52 and VT102.    TTY and ANSI are two of the more common types for 
connecting to personal computers.    VT100 is more common with larger mainframe style 
computers like Compuserve.

Related Topics:

Colors
VT100



Configure Send Fax Settings
The Send Fax Setup option in the Setup Menu allows various options to be set for sending faxes.

Center Text/Graphics On Page

Centers text or graphics information horizontally on the page.

High Resolution

Allows documents to be sent at high resolution.    High resolution is 200 x 200 dots per inch.    
Normal resolution is 200 x 100 dots per inch.    Documents should be converted and sent at the 
same resolution.    Otherwise, unpredictable results could occur.

Full Page Text/Graphics

Forces a full fax page to be sent no matter how much information is on the page.    For example, if
the document only has one line of text, a full 8½ x 11 sheet of paper will be sent.

Page Layout

Various aspects of the page may be adjusted including page width and height, margins and the 
width of tab stops with the Page Layout options.

Include Cover Page

Sends a cover page along with the document to be faxed.

Dedicate CPU During Send

Dedicates the entire CPU during the process of sending a fax.    If dedicate CPU is enabled, other
programs running will be suspended until the fax transmission is complete.    If problems occur 
with your modem hanging up at undesirable times, enable Dedicate CPU.

Delete Fax Files After Send

Deletes converted fax files after they have been sent.

Remove Fax Manager After Send

Removes the Fax Manager program from memory after the fax transmission.

Run Fax Manager Maximized



Enables the Fax Manager to be initially loaded in its full windowed state.

RTS/CTS Flow Control On Fax Send

Uses RTS/CTS hardware flow control during a fax send instead of XON/XOFF software flow 
control.

Re-Dial Attempts

Specifies the number of times QuickLink should re-dial a number after a busy signal has been 
detected.

Re-Dial Delay

Specifies the amount of time QuickLink should wait before re-dialing a phone number.

Max Fax Baud

Specifies the maximum baud rate that QuickLink may use while sending a fax. 

Related Topics:

QuickLink Outbox



Configure Receive Fax Settings
The Receive Fax Setup option in the Setup Menu configures various options used during the receipt of 
faxes.

Fax ID String

Specifies the text ID to be sent to the sending fax machine.    This text is only to let the sending 
machine know who it is sending to.    The Fax ID String does not have to be entered for proper 
operation.

Load Fax Manager At Windows Startup

Enables the loading of Fax Manager automatically when Windows is started.

Enable Fax Receiving At Fax Manager Startup

Enables faxes to be received as soon as the Fax Manager is loaded.

Run Fax Manager Maximized

Runs the Fax Manager program in its full windowed state instead of as an icon.

Beep On Receive

Alerts you with a beep when a fax has been received.

Display Message Box On Receive

Alerts you with a message box when a fax has been received.

Dedicate CPU On Receive

Dedicates the entire CPU to the Fax Manager during the receipt of a fax.    When Dedicate CPU is
enabled, all other programs running will be suspended until the fax transmission is complete.    If 
problems occur with the fax modem hanging up at undesirable times, enable Dedicate CPU.

Spawn QuickLink On Data Call

Launches QuickLink automatically when a data call has been detected.    This option is only 
available if the Fax Manager is loaded into memory.

Print On Receive



Enables QuickLink to automatically print incoming faxes on your printer.    Use the Select button to
select which printer to print to if more than one printer is configured.

Related Topics:

QuickLink Inbox



Configure Cover Page Settings
The Cover Page Setup option in the Setup Menu allows you to define options for the fax cover page.

Enter text into the appropriate fields for Company Name, Fax From, Fax Number and Voice Number.    
Any or all fields may be blank.

A cover page graphic may be selected which will be placed at the top of the cover page.    Graphics must 
be in a format that is convertible by QuickLink.    Valid file types are TEXT, BMP, TIFF, PCX, DCX and 
MacPaint.

To select the graphic file, type in the full DOS path and file name in the Cover Page Graphic field or you 
may select it from available files on your disk by clicking on the Browse button.

To un-select a cover page graphic, erase the file name in the Cover Page Graphic field.



Configure On-Line Services Settings
The Services Setup option in the Setup Menu sets up account and phone number information for quick 
access to Compuserve, Genie and Dow Jones on-line services.

Account information may be entered for automatic logging into Compuserve, Genie, or Dow Jones.    
Enter the appropriate data in the ID or Account and Password fields.

Select which network service you will be using, Telenet, Tymnet or Compunet.    You can find out the 
appropriate network by contacting the service.

Enter the telephone number for the service in one of the network phone number fields.    Be sure to enter 
the number in the corresponding field with the network service.

Related Topics:

Accessing Compuserve
Accessing Genie
Accessing Dow Jones



Configure Macro Keys
The Macro Keys option in the Setup Menu sets up single key launching of scripts or the output of literal 
text.

Twelve hot keys (F1 to F12) may be set up to automatically run QuickLink scripts or output literal text to 
the terminal window.

To output a literal string when a function key is pressed, enter the text in the corresponding edit field.    If a
carriage return is required after the text is output, it can be simulated by entering "\r" after the text in the 
edit field.

Characters that do not appear on your keyboard may also be output as long as the character is part of the
standard ASCII character set.    For example, if you needed to output an ESCAPE character (ASCII 27) 
you would enter a backslash "\", followed by the ASCII value 27.    It would be entered in the form of "\27". 
Do not enter any leading zeros in the ASCII value.

To launch a script when a function key is pressed, enter the file name of the script in the corresponding 
edit field.    Click on the script box next to the edit field to enable the script launching.    If text has not been
entered in the edit field when the script box is checked, a dialog will pop up allowing you to select the 
script name from the available files on your disk.

Related Topics:

Running Scripts
Script Language Reference
ASCII Chart



Configure Connection Settings
NOTE:    This menu item will only be available if your modem supports software error correction and 
compression.

The Connection Setup option in the Setup Menu sets up MNP/V.42/V.42bis connection parameters.    
This dialog applies type of connection made during the answering of incoming data calls, and calls dialed 
with the Dial command.

Each entry in the Data Phone List has a separate Connection Setup dialog box.    When you select add 
an entry to the Data Phone List, a Connection button will be available which will open the Connection 
Setup Dialog for that phone list entry.

Protocol Type

This group of radio buttons selects which type of connection you wish to make.    This is the most 
important selection in Connection Setup.    V.42 Auto-reliable will instruct the QuickLink software 
to try to connect using V.42 first, then try MNP, then if both fail, connect as a standard modem.    
V.42 Reliable will only try to make a V.42 connection and if no V.42 connection is established, the 
call will be terminated.    MNP Only means that only a MNP connection will be tried.    The None 
selection will instruct QuickLink to make a normal data connection without error correction.    If 
you are having trouble connecting with the other selections, try using the None connection type.

V.42bis Type

If a V.42 connection is made, this option tells QuickLink how to use V.42bis. The Both selection is 
the most common and is the default.    If you wish to disable V.42bis with a V.42 connection, select
the Disabled option.

MNP 5 compression

If an MNP connection is made, this check box will control the use of the MNP 5 data compression
method.    If you wish to disable the use of MNP 5 during a MNP connection, un-check this option.



Configure Modem Settings
The Modem Setup option in the Setup Menu sets up initialization and command strings for the modem.

Init String

The initialization string sent to the modem during QuickLink startup.    Any valid AT command may 
be placed in this string.    Refer to your modem documentation for a listing of the AT command set.
If your modem supports the S95 register, you may add S95=40 in your initialization string to have 
the protocol and compression displayed after a data connection.    If your modem doesn't support 
S95, but supports the W command, you may add W1 in your initialization string to display the 
protocol after a data connection.

For QuickLink to correctly operate, the S0 register must not be set to anything but zero.    This 
register tells the modem on what ring to answer the phone, but QuickLink needs to have control 
of when the modem will answer.

Dial String

Command sent to dial the modem.

Dial String Options

Various commands can be inserted into the dial string automatically.    These options include 
pulse or tone dial, detect dial tone, detect busy signal, or disable call waiting.    The standard 
command to disable call waiting is *70.    If a different command is required for your phone 
system, this command will have to be entered into the dial string manually.

Hang Up String

Command sent to hang up the modem connection.

Dial Prefix/Suffix

Numbers that need to be dialed before the normal telephone number may be placed here.    For 
example, you could put a calling card account number in the dial prefix to be dialed before the 
normal telephone number.

Answer Mode

The answer mode allows you to select the type of calls QuickLink will acknowledge.      The 
choices are:



Ignore Ring Never answers the phone
Fax Only Answers all calls but only responds to incoming fax calls
Data Only Answers all calls but only responds to incoming data calls
Fax & Data Answer all calls and responds to both fax and data calls

Unless you select never answer (ignore ring), the call will always be picked up, and a detection 
tone will be emitted to the caller.

If your modem has Distinctive Ring capabilities, QuickLink may be able to take advantage of 
them.    If so, the Distinctive Ring option will be one of the choices in the Answer Mode box.    
Selecting Distinctive Ring will enable the Ring Type button which allows you do determine what 
action to take for each type of ring detected.

Comm Port

Selects the communications port to which your modem is connected.

Answer On # Rings

Set the number of rings on which to answer the phone.    Depending on the computer speed, it 
may take 1 to 2 extra rings to actually answer the phone.

Caller ID

If your modem has caller ID capabilities, your version of QuickLink may have the Caller ID check 
box.    Checking this box will enable the Fax Manager to display any caller ID information as it is 
received.    Un-checking this item will cause the Fax Manger to ignore any caller ID information 
received.

Hardware

Selects the class of modem for QuickLink to use.    The modem class is automatically detected 
during initial startup of QuickLink.    If you change modem types, you may need to set this option 
manually.    Be sure to select the correct type for your particular modem.

Default

Sets the modem settings to their default values.



Do not remove this directory.    CMW 8/95



Do not remove this directory.    CMW 8/95



Do not remove this blank page.    CMW 8/95





Troubleshooting
This section describes some common errors and help for fixing them.

1. The sent fax comes out squashed or elongated.

The fax was sent using a different resolution than when the fax was converted.    Ensure 
that the resolution setting is the same for both cases.

2. Laser printers will not print using a high resolution.

The printer does not have enough internal memory to store the entire page at high 
resolution.    More memory must be added to the printer or a lower resolution must be 
used during printing.

3. Graphic files come out very large after conversion.

The graphic files are saved at either a very high resolution or low resolution.    This mostly
occurs in scanned graphic files that were scanned at unsupported resolutions.    Graphics 
should be scanned at resolutions ranging from 100 to 200 dots per inch.

4. "Unable to convert file - Bilevel error" message appears when converting Windows BMP 
files.

In order for BMP files to be converted to Fax, they must be black and white format.    BMP
files may contain only the colors black and white but they are not true black and white 
files.    Files must be saved as Monochrome Bitmap in Windows Paintbrush.    This option 
can be found be selecting the Options button on the Save dialog.

5. "Modem not a fax modem" or "Unable to detect modem" message appears when sending a
fax.

A memory or port conflict is present on the system or inappropriate software is being 
used with the modem.    Ensure that the appropriate software is being used with the 
modem such as class 1 software with a class 1 fax modem or send/receive software with 
a send/receive modem.    If proper software is being used, check for any memory or port 
conflicts.

If your modem is located on COM3 or COM4, Windows 3.0 sometimes has a problem 
with these ports in 386 Enhanced mode.    If you are having problems sending or 
receiving faxes and your modem is on COM3 or COM4, you may wish to move your 
modem to COM1 or COM2 or upgrade to Windows version 3.1.

Related Topics:

Error Codes






